This version of the software has been retired.
This is a publication of Sage Software, Inc.

Copyright © 2014. Sage Software, Inc. All rights reserved.

Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc. or its affiliated entities. All other trademarks are the property of their respective owners.

Microsoft® SQL Server®, Windows Vista® and the Windows logo are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or in other countries.

Your use of this document and the Sage product(s) described herein is governed by the terms and conditions of the Sage End User License Agreement ("EULA") or other agreement that is provided with or included in the Sage product. Nothing in this document supplements, modifies or amends those terms and conditions. Except as expressly stated in those terms and conditions, the information in this document is provided by Sage "AS IS" and Sage disclaims all express, implied or statutory warranties of any kind, including but not limited to the warranties of merchantability, fitness for a particular purpose or of non-infringement. No implied license is granted to you under any Sage intellectual property or trade secret right. Sage reserves the right to revise, supplement or remove information in this document at any time without notice to you or others.

Sage End User License: http://na.sage.com/sage-na/eula

Date: 6/20/2014
## Contents

### Chapter 1: Welcome to Sage 100 Contractor Installation

- How to Read this Document ................................................................. 1
- Customer Support and Resources .......................................................... 2
- Training Resources .................................................................................. 4
- Business Partners ................................................................................... 5
- Business Forms ....................................................................................... 5

### Chapter 2: System Requirements and Configuration

- Internet Access Required for Sage 100 Contractor .................................. 6
- Hardware Requirements ........................................................................... 6
- Operating Systems Requirements ............................................................. 8
- Supported Microsoft Office versions ....................................................... 9
- Network Configuration Requirements ...................................................... 9
- Microsoft .NET Framework 4.0 Requirements ......................................... 13
- Windows permissions required for Sage 100 Contractor ............................ 14
- Report Scheduling and Faxing Functionality ............................................. 17
- Sage 100 Contractor API ......................................................................... 18

### Chapter 3: Sage 100 Contractor Installation

- Installation Preview .................................................................................. 20
- New Installations ..................................................................................... 23
- Upgrade Installations ............................................................................... 25
- Uninstalling Sage 100 Contractor from a Sage license server .................... 27

### Chapter 4: ACT! Plug-in Installation

- Pre-installation information ................................................................... 28
- Duration of the installation process ......................................................... 28
- Additional required software ................................................................. 28
- Installing the ACT! Plug-in ..................................................................... 28

### Chapter 5: Sage Construction Anywhere Installation

- Additional required software ................................................................. 30
Duration of the installation process .......................................................... 30
Pre-installation information ................................................................. 30
Setting up Sage Construction Anywhere Integration ................................. 30
Setting up an API security group and an API user in Sage 100 Contractor ................................................................. 31

Chapter 6: Managing Your License .......................................................... 33
License Administration ........................................................................... 33
Managing Licenses ................................................................................. 38
Troubleshooting License Issues .......................................................... 39

Chapter 7: License Use and Sage 100 Contractor .................................... 41
Specify Sage License Server .................................................................. 41

Chapter 8: Special Configurations—Operating Systems and Services .... 43
Windows 8 Professional and Server 2012 Standard Operating Systems ................................................................. 43
Windows 7 Professional and Server 2008 R2 Standard Operating Systems ................................................................. 44
Windows Vista and Server 2008 Operating Systems ................................................. 45
Citrix and Terminal Servers .................................................................. 47
Backing Up Your Data ........................................................................... 47
Configuring Windows Regional and Short Date Format: ......................... 49

Index ..................................................................................................... 50
Chapter 1: Welcome to Sage 100 Contractor Installation

Welcome to Sage 100 Contractor installation. Sage 100 Contractor can run in many different software and network environments. Because of that, there are considerations you need to make as you prepare for installation. The more you understand about the installation process and how it relates to your software and network environment, the more likely your installation will proceed smoothly.

This chapter provides more information about customer resources, such as:

- Other printed and printable guides
- The user-assistance Help system
- Contacts for Customer Support
- Sage 100 Contractor training
- Information about business partners.

How to Read this Document

This document uses the following conventions:

- The names of screens, windows, fields, and other features displayed by the software are shown in bold type.
- Information you enter into the software is in bold type, as in the following example: Enter Miscellaneous in the Amount Type box.
- Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates that you should press both keys at the same time; for example, SHIFT + TAB.
- The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] and [Post].

TIP: This symbol draws your attention to helpful information to make it easier for you to use Sage 100 Contractor.

NOTE: This symbol draws your attention to information of particular interest, such as information not included in steps.

CAUTION: This symbol draws your attention to information that is important because it can help you avoid a costly or time-consuming error.

IMPORTANT: This symbol draws your attention to information that is of critical importance.
Customer Support and Resources

Before you contact Customer Support

Before you decide to contact the customer support call center, be sure to take advantage of the resources available to you. These services are available 24 hours a day, 7 days a week.

Sage 100 Contractor Help

From anywhere within the software, you can access this comprehensive library of easy-to-find topics to learn more about specific procedures, topics, fields, or buttons.

Sage Knowledgebase

Depending on your Sage service plan, we also offer a web-based Sage Knowledgebase and online user community forums at www.sagecre.com or through the in-product menu. Our staff maintains an extensive knowledge database of questions and answers covering everything from frequently asked questions to more complex problems and solutions. In addition, we keep all product reference documentation available in the Knowledgebase. This online tool is the same tool we use in our customer support call center to help answer your call.

To access the Technical Support Knowledgebase:
2 On the Welcome page, in the left column, click Knowledgebase Search to open a list of products.
3 Complete Step 1 by selecting Sage 100 Contractor from the list of products.
4 Complete Step 2 by entering a search term in the box.
5 Click Search. The search results appear below the box.

Sage 100 Contractor InfoCenter

Find Sage 100 Contractor software notices and all the information you need, such as industry news, products, services, new enhancements, tips, training, special offers and more.

http://www.na.sage.com/sage-100-contractor/infocenter-news

Technical Documentation Available

A number of guides are included in the software. Access important release information such as system requirements, software enhancements, quickly and easily. Click the Home & Resources tab > Printable Documentation or Resources > Printable Documentation if you have Activity Centers hidden to see the available PDF files. You can also find the PDF files in the Documentation folder in \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor\.

Sage 100 Contractor Virtual Conference

Interact with and learn from Sage Construction and Real Estate senior leadership, product experts, and fellow customers online. Get the latest information on product updates as well as network and share experiences with your peers. Check the Sage 100 Contractor InfoCenter at http://www.na.sage.com/sage-100-contractor/infocenter-news for current virtual conference information.
Contacting Customer Support

Contact Customer Support in the United States and Canada at:

Toll free: 800-866-8049
Or 503-690-6775
www.sagecre.com

Hours of Operation

Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the exceptions listed below.

- Every Thursday from 2 p.m. to 3 p.m. Pacific Time, closed for staff meetings.
- Standard United States holidays.
- Quarterly company meetings.

You can also submit your request for customer support online 24 hours a day, seven days a week by logging on to http://na.sage.com/us/sage-construction-and-real-estate. Our customer support team will reply to your questions during normal support hours.

Any additional closures will be communicated by our regular customer email newsletters.

When You Contact Customer Support

Depending on your Sage service plan, you may be able to contact the Sage Customer Support Call Center to work with one of our highly trained customer support professionals. Before you call, be sure to have the following information on hand so we can handle your call efficiently.

<table>
<thead>
<tr>
<th>Question</th>
<th>How to Find the Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is your Sage client ID number?</td>
<td>Your client ID number can be found on correspondence you receive from Sage. If you do not know your Sage client ID, contact the person at your company who maintains your relationship with Sage.</td>
</tr>
<tr>
<td>What software version are you using?</td>
<td>To find the version, open Sage 100 Contractor; click Help &gt; About Sage 100 Contractor and note the number listed.</td>
</tr>
<tr>
<td>What application or area in the software are you calling about?</td>
<td>On the menu list, identify the application and number where are you are work (i.e. Selecting Invoices to Pay in 4-3-1, Accounts Payable Vendor Payments).</td>
</tr>
<tr>
<td>How can we help you?</td>
<td>Walk through the exact steps you completed with as much detail and accuracy as possible.</td>
</tr>
<tr>
<td>Is there an error message?</td>
<td>Write down the exact wording of the message.</td>
</tr>
<tr>
<td>Can you reproduce the issue?</td>
<td>Were you able to walk through the same steps that led to the problem and see whether it happened again?</td>
</tr>
</tbody>
</table>
### Question | How to Find the Answer
--- | ---
Is this the first time the problem has happened? Does the problem occur on one workstation or several? | Ask other users if they have experienced the same problem. Have them test at their workstation to see if they experience the same problem. Also, have the original user try other workstations to see whether the problem is specific to that user.
Has anything changed with your software, hardware, or workflow? | Ask your network administrator for technical information regarding anything that may have changed behind the scenes: upgrades to Sage 100 Contractor, new third-party software installations, moving of data from one server to another, new printers or print driver installation, or anything else that might affect the network.
Does the problem happen in the sample data sets? | Select [File> Open Company], then change the drive letter on the dropdown to C:, select Sample Company.
What kind of network are you using? | If you do not know, contact your network administrator.
What operating system is on your computer? | For Vista: Click [Start], type winver in the ‘start search’ window and click [OK].
What printers and print drivers are installed? | If you do not know, contact your network administrator.
When was your last backup? | If you do not know, contact your network administrator.

### Responding to You
Our analysts work with you to respond accordingly to the urgency of your issue. Call urgencies range from a simple explanation of software settings to critical situations in which work is stopped or data integrity is compromised. Some calls may warrant further research and followup, in which case our support analyst will place your call in his/her in-progress work list. At every step of the way, we work with you to until a resolution or agreement can be reached.

Depending on your Sage Service plan, you may check the status or update, or even create a new support ticket online:

2. Click the [Customer Support] button.
4. Next, select the Support tab and choose the [Self Service] button.

### Training Resources
When you choose to take online classes from Sage or work with a Sage business partner, you will learn how to use Sage 100 Contractor to support your business. Contact your business partner to find out about training options or visit Sage University at [http://www.sageu.com](http://www.sageu.com).

### Online Classes
Online classes help you maximize your use of Sage 100 Contractor. Online classes are a convenient training option for your company and new users to learn more about Sage 100 Contractor so you can get the most out of the software. You can
select from classes on all aspects of Sage 100 Contractor, including project management, estimating, scheduling, service management and payroll. Each online class is led by an instructor with years of experience using Sage 100 Contractor. During the class, you will be able to follow along as the instructor demonstrates functions and workflows in Sage 100 Contractor. In the online live session, you can ask questions and benefit from hearing answers to other students’ questions.

For more information, visit http://www.sageu.com.

**Getting Started as a New User**

We recommend that all new users should begin with our New Customer Training (NCT) series, which is included in our Essentials Training Package in recorded format for 24/7 access. If you prefer live online training led by an instructor, you can register for the Realtime Learning version of these NCT courses. For more information, visit http://www.sageu.com.

**Business Partners**

To serve you better, Sage 100 Contractor products and services are available to you through an authorized network of business partners. Business partners have local expertise and regional knowledge working with contractors in the region.

Your business partner is available to serve you, from simple how-to questions and hands-on demonstrations, to installation, implementation, and training. They're fully equipped to help you get where you want to be. For more information, contact your Sage 100 Contractor business partner.

**Business Forms**

Sage 100 Contractor is designed to work with generic checks and forms that are available from many sources. There is no single vendor that customers must use; however, you can get a complete portfolio of forms, tax forms, and checks through Sage Construction and Real Estate Forms by calling 800-760-7929 or by visiting www.sagecreforms.biz.
Chapter 2: System Requirements and Configuration

This chapter presents technical information about:

- System requirements for servers and client workstations
- Supported operating systems
- Special configurations for specific operating systems

Be sure your computers meet the system requirements before you install the software, as Sage 100 Contractor will not run correctly or at all on computers that do not meet the minimum requirements.

Internet Access Required for Sage 100 Contractor

Sage 100 Contractor features, such as printing or e-filing tax forms, submitting enhancement requests, accessing Help, or downloading periodic product or tax updates all require Internet access.

To take advantage of these features, ensure that any workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage 100 Contractor is installed, then disconnect the Sage license server from the Internet.


Hardware Requirements

Server hardware specifications

We cannot recommend server hardware specifications for your network, as this depends on your specific requirements, such as the number of users on your network, or other programs that might use server resources, such as firewalls, software applications, mail systems, and so forth. We can, however, recommend a set of minimum hardware requirements.

**NOTE:** When you have a network with three or more users, a dedicated file server increases performance and reliability.

Server hardware requirements

The following table shows the operating systems that are supported for the server computers running Sage 100 Contractor.
NOTE: The minimum processor requirements for servers listed in the table below are based on the Microsoft® Windows® Server 2003® operating system family. When updating or purchasing servers running newer operating systems such as Windows Server 2012 Standard, Windows Server 2012 Essential, Windows Server 2008®, Small Business Server® 2008, and Server 2008 R2 Standard, we recommend that you also refer to Microsoft system requirements.

<table>
<thead>
<tr>
<th>Server Hardware</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Intel® Pentium® 4 or comparable, 1 GHz</td>
<td>Intel® Dual Core/Quad Core™ or comparable, 2 GHz+</td>
</tr>
<tr>
<td>RAM</td>
<td>2 GB</td>
<td>4 GB+</td>
</tr>
<tr>
<td>Free Disk Space</td>
<td>10 GB</td>
<td>40 GB+</td>
</tr>
<tr>
<td>DVD-ROM Drive</td>
<td>DVD-ROM Drive</td>
<td>DVD-ROM Drive</td>
</tr>
<tr>
<td>Printers</td>
<td>For highest quality printing, we recommend laser or inkjet printers.</td>
<td></td>
</tr>
</tbody>
</table>

IMPORTANT: These minimum recommendations include the 600 MB required for running Microsoft .NET Framework 4.0 software. The recommended free disk space is based on the installation of a single program and the average size of a Sage 100 Contractor company database. Allow at least 50 MB for each additional company database that you create.

Client and workstation hardware requirements

The following table shows the hardware requirements for client and workstation computers running Sage 100 Contractor.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vista/Windows 7/Windows 8 processor</td>
<td>1 GHz</td>
<td>2 GHz+</td>
</tr>
<tr>
<td>RAM (except Vista/Windows 7/Windows 8)</td>
<td>1 GB</td>
<td>2 GB+</td>
</tr>
<tr>
<td>Vista/Windows 7/Windows 8 workstation RAM</td>
<td>2 GB</td>
<td>4 GB+</td>
</tr>
<tr>
<td>Free Disk Space</td>
<td>16 GB</td>
<td>20 GB+</td>
</tr>
<tr>
<td>CD-ROM Drive</td>
<td>2X CD-ROM</td>
<td>DVD-ROM</td>
</tr>
<tr>
<td>Printers</td>
<td>For highest quality printing, we recommend laser or inkjet printers.</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: These minimum recommendations include the 600 MB required for running Microsoft .NET Framework 4.0 on client workstations. The recommended free disk space is based on the installation of a single program and the average size of a Sage 100 Contractor company database. Allow at least 50 MB for each additional company database that you create.

Sage 100 Contractor supports virtual server environments

In addition to the performance and cost savings benefits, virtualization is expected to be a commonly used technology in the construction industry. Contact Customer Support if you are planning to run Sage 100 Contractor in a virtual environment. Business partners are expected to configure and support the virtualization itself. For more information, please contact your Sage 100 Contractor business partner.
Operating Systems Requirements

Operating systems

Use one of the supported operating systems below for a smooth and successful installation experience.

Supported Operating Systems

<table>
<thead>
<tr>
<th>Server Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows Server 2012 Standard</td>
</tr>
<tr>
<td>Microsoft Windows Server 2012 Essentials</td>
</tr>
<tr>
<td>Microsoft Windows Small Business Server 2011 Standard</td>
</tr>
<tr>
<td>Microsoft Windows Server 2008 R2 Standard</td>
</tr>
<tr>
<td>Microsoft Windows Small Business Server 2008</td>
</tr>
<tr>
<td>Microsoft Windows Server 2008</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client/Workstation Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 8 Professional</td>
</tr>
<tr>
<td>Microsoft Windows 8 Enterprise</td>
</tr>
<tr>
<td>Microsoft Windows 7 Professional</td>
</tr>
<tr>
<td>Microsoft Windows 7 Ultimate</td>
</tr>
<tr>
<td>Microsoft Windows Vista Business</td>
</tr>
</tbody>
</table>

Unsupported Operating Systems

**NOTE:** Sage 100 Contractor and/or its components do not run on or do not support some operating systems. Do not install Sage 100 Contractor to computers running these Microsoft Windows operating systems:

- Apple operating system, any version
- Microsoft Windows 95
- Microsoft Windows 98
- Microsoft Windows NT Server
- Microsoft Windows NT Workstation
- Microsoft Windows 2000
- Microsoft Windows 2000 Server
- Microsoft Windows 2003 Server
- Microsoft Windows XP Professional (32-bit and 64-bit editions)
- Microsoft Windows XP Home
- Microsoft Windows Vista Home Basic
- Microsoft Windows Vista Home Premium

**IMPORTANT:** Microsoft .NET Framework 4 must be installed to all computers running Sage 100 Contractor and License Administration. During installation, both Microsoft .NET Framework 3.5 Service Pack 1 and Microsoft .NET Framework 4 are installed on your computer automatically if they are not already installed. Be sure that all server and client computers meet both .NET Framework requirements and Sage 100 Contractor requirements.

**Supported Web Browsers**

Sage 100 Contractor supports Internet Explorer 9 and later.

**Supported Microsoft Office versions**

The following table shows which versions of Microsoft Office are supported in Sage 100 Contractor.

<table>
<thead>
<tr>
<th>Supported Microsoft Office Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Office 2003</td>
</tr>
<tr>
<td>Microsoft Office 2007</td>
</tr>
<tr>
<td>Microsoft Office 2010</td>
</tr>
<tr>
<td>Microsoft Office 2013</td>
</tr>
</tbody>
</table>

**Network Configuration Requirements**

**Server network configuration requirements**

The following table shows the server network configuration requirements for server computers running Sage 100 Contractor.

**IMPORTANT:** You must allow HTTPS outgoing traffic on port 443 to the outside Internet. This is a requirement of the licensing and entitlement service and for Sage Construction Anywhere connectivity.

<table>
<thead>
<tr>
<th>Process</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Protocol</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Minimum Network Speed—LAN</td>
<td>10/100/1000 Mbps</td>
</tr>
<tr>
<td>Minimum Network Speed—WAN</td>
<td>+/- 1.5 Mbps receiving data (downstream)</td>
</tr>
<tr>
<td></td>
<td>+/- 384 Kbps sending data (upstream)</td>
</tr>
</tbody>
</table>

**NOTE:** Sage 100 Contractor typically runs in a local area network (LAN) environment. Sage 100 Contractor can run in a wide area network (WAN) using Citrix or Terminal Services. Contact your Sage business partner for more information.

**CAUTION:** We recommend that you do not attempt to run Sage 100 Contractor over a wireless network.
Client and workstation network configuration

The following table shows the server network configuration requirements for client and workstation computers running Sage 100 Contractor.

**IMPORTANT:** The Sage 100 Contractor Hosting Framework service must be unblocked from accessing incoming connections. This is done automatically when using the Windows Firewall, but other firewalls running on the server may require additional configuration.

<table>
<thead>
<tr>
<th>Process</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Protocol</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Minimum Network Speed—LAN</td>
<td>10/100/1000 Mbps</td>
</tr>
<tr>
<td>Minimum Network Speed—WAN</td>
<td>128 Kbps Broadband</td>
</tr>
</tbody>
</table>

**NOTE:** For information about running Sage 100 Contractor in a wide area network (WAN) using Citrix and Terminal Services, contact your business partner.

**CAUTION:** We recommend that you do not attempt to run Sage 100 Contractor over a wireless network.

About network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations can potentially disable the communication:

- File sharing on computers running the Windows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Help.
- TCP communication requires the selection of port numbers that are not in use by other processes on the local computer.
- Software firewalls running on the local computer can be configured to block processes from opening TCP ports, which will prevent communication through the TCP Remoting Channel.

Configuring anti-virus software and third-party firewalls

During installation of the Sage 100 Contractor Hosting Framework, the Windows Firewall is configured automatically to allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you may need to manually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure to manually configure the Windows Firewall to allow the Sage 100 Contractor Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party firewall products.

**To configure the Windows Firewall:**

1. For Windows Vista or Server 2008, click **Start > Control Panel > Security.**
   For Windows 7, click **Start > Control Panel > System and Security**
   For Windows 8, click **Start > All apps > Control Panel > System and Security.**
2. Open **Windows Firewall**, and then select **Allow a program or feature through Windows Firewall.**
3. If Sage 100 Contractor Hosting Framework is not on the list, you can add it by selecting **Add Program**, then browsing to the following path: 
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

**NOTE:** By default, the exception is set to allow access by any computer on the network. You can refine this setting by selecting the **Change Scope** button. Be aware that restricting the scope incorrectly can cause the computer to be unable to connect with some or all of the other machines on the network.

### Files to exclude when manually configuring your firewall for Windows 8 Professional 32-bit
- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

### Files to exclude when manually configuring your firewall for Windows 8 Professional 64-bit
- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

### Files to exclude when manually configuring your firewall for Windows Vista 32-bit
- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor

Network location of Sage 100 Contractor data

### Files to exclude when manually configuring your firewall for Windows Vista 64-bit
- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files\Sage\Sage 100 Contractor
- C:\ProgramData\Aatrix Software
- C:\Program Files\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional

- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Sage\Sage 100 Contractor
- C:\Program Files (x86)\Aatrix Software
- C:\ProgramData\Aatrix Software
- C:\%LocalAppData%\Sage\Sage 100 Contractor
- Network location of Sage 100 Contractor data


- C:\MB7
- C:\ProgramData\Sage\Sage 100 Contractor
- C:\ProgramFiles (x86)\Sage\Sage 100 Contractor
Microsoft .NET Framework 4.0 Requirements

About installation and Microsoft .NET Framework

When you install Sage 100 Contractor software, you will also install the Microsoft .NET Framework 4.0, if it is not already installed. It is important that you make sure that both your client and server computers meet the minimum requirements for installing both Sage 100 Contractor software and Microsoft .NET Framework 4.0.

**IMPORTANT:** If the Sage 100 Contractor installation requires an installation of Microsoft .NET Framework 4.0, the Sage 100 Contractor installation process may continue automatically after the .NET Framework installation is completed. If you are prompted to restart your computer after the .NET Framework installation, however, you must do it to continue the Sage 100 Contractor installation.

About installing .NET Framework 4.0 and Operating Systems

**NOTE:** If Microsoft .NET Framework 4.0 is not already installed on your computers, that installation alone may take up to 20 minutes per computer.

The following operating systems are supported for .NET Framework 4.0:

<table>
<thead>
<tr>
<th>Server Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows Server 2012 Standard</td>
</tr>
<tr>
<td>Microsoft Windows Server 2012 Essentials</td>
</tr>
<tr>
<td>Microsoft Windows Small Business Server 2011®</td>
</tr>
<tr>
<td>Microsoft Windows Server 2008 Standard Edition</td>
</tr>
<tr>
<td>Microsoft Windows 2008® Small Business Server</td>
</tr>
<tr>
<td>Microsoft Windows Server 2008® R2 Standard Edition</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client/Workstation Operating Systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 8 Professional</td>
</tr>
<tr>
<td>Microsoft Windows 8 Enterprise</td>
</tr>
<tr>
<td>Microsoft Windows 7 Professional</td>
</tr>
<tr>
<td>Microsoft Windows 7 Ultimate</td>
</tr>
<tr>
<td>Microsoft Windows Vista Business</td>
</tr>
</tbody>
</table>
Viewing and verifying system information

For Windows Vista, Windows 7, and Windows 8, use MSinfo32.exe to open the System Information window to view your system information. To view and verify system information on Windows Vista, Windows 7, and Windows 8:

1. Click [Start], then type [Run].
2. The [Run] dialog box opens.
3. In the [Open] text box, type MSinfo32.exe, and then press the Enter key.

The System Information window opens displaying a list of your system information.

.NET Framework Requirements for Server Computers

Minimum requirements for Microsoft .NET Framework 4.0 on servers

<table>
<thead>
<tr>
<th>Component</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space at installation</td>
<td>800 MB</td>
</tr>
<tr>
<td>Video card</td>
<td>800x600, 256 colors</td>
</tr>
</tbody>
</table>

.NET Requirements for Client Computers

Minimum requirements for the Microsoft .NET Framework 4.0 on clients

<table>
<thead>
<tr>
<th>Component</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk space at installation</td>
<td>600 MB</td>
</tr>
<tr>
<td>Video card</td>
<td>800x600, 256 colors</td>
</tr>
</tbody>
</table>

Windows permissions required for Sage 100 Contractor

When you install Sage 100 Contractor, work with your system administrator to configure the Windows-level security that corresponds to the operating system installed on each workstation where Sage 100 Contractor will be used. Without the correct permissions, users may have difficulty operating Sage 100 Contractor.

⚠️ CAUTION: Always back up your data before changing Windows permissions! Setting Windows security incorrectly can adversely affect system operations. Sage is not responsible for problems caused by incorrectly configured Windows settings.

All the directories listed below must have Full Control, Modify, Read & execute, List folder contents, Read, and Write permission. Special permissions are not required.
<table>
<thead>
<tr>
<th>Windows component/ version</th>
<th>Directories</th>
</tr>
</thead>
</table>
| Registry Keys             | HKEY_Current_User\Software\Sage  
HKEY_Local_Machine\Software\Wow6432node\Sage  
HKEY_Current_Config\Software\Sage 100 Contractor PDF Export  
HKEY_Current_Config\Software\Sage 100 Contractor RTF Export |
| Windows 8 Professional 32-bit | C:\MB7  
C:\ProgramData\Sage\Sage 100 Contractor  
C:\Program Files\Sage\Sage 100 Contractor  
C:\ProgramData\Aatrix Software  
C:\Program Files\Aatrix Software  
C:\%LocalAppData%\Sage\Sage 100 Contractor  
Network location of Sage 100 Contractor data |
| Windows 8 Professional 64-bit | C:\MB7  
C:\ProgramData\Sage\Sage 100 Contractor  
C:\Program Files (x86)\Sage\Sage 100 Contractor  
C:\Program Files (x86)\Aatrix Software  
C:\ProgramData\Aatrix Software  
C:\%LocalAppData%\Sage\Sage 100 Contractor  
Network location of Sage 100 Contractor data |
| Windows 7 Professional 32-bit | C:\MB7  
C:\ProgramData\Sage\Sage 100 Contractor  
C:\Program Files\Sage\Sage 100 Contractor  
C:\ProgramData\Aatrix Software  
C:\Program Files\Aatrix Software  
C:\%LocalAppData%\Sage\Sage 100 Contractor  
Network location of Sage 100 Contractor data |
<table>
<thead>
<tr>
<th>Windows component/ version</th>
<th>Directories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7 Professional 64-bit</td>
<td>C:\MB7 C:\ProgramData\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files (x86)\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files (x86)\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:%LocalAppData%\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>Network location of Sage 100 Contractor data</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramFiles (x86)\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files (x86)\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:%LocalAppData%\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>Network location of Sage 100 Contractor data</td>
</tr>
<tr>
<td>Windows Vista 32-bit</td>
<td>C:\MB7</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:%LocalAppData%\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>Network location of Sage 100 Contractor data</td>
</tr>
<tr>
<td>Windows Vista 64-bit</td>
<td>C:\MB7</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files (x86)\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>C:\Program Files (x86)\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:\ProgramData\Aatrix Software</td>
</tr>
<tr>
<td></td>
<td>C:%LocalAppData%\Sage\Sage 100 Contractor</td>
</tr>
<tr>
<td></td>
<td>Network location of Sage 100 Contractor data</td>
</tr>
</tbody>
</table>
Report Scheduling and Faxing Functionality

About setting up emailing and faxing through Sage 100 Contractor

Using the faxing functionality through the Sage 100 Contractor program requires:

- Installation of the Windows operating system Fax Service component
- A separate installation and setup of a fax modem in your workstation
- Access to an analog phone line.

In addition, you will also have to set up the cover page information and the number of times that the fax re-tries to send.

For more information about installing and setting up your fax modem, refer to the documentation that came with your fax modem. Sage 100 Contractor does not provide support for installing or setting up a fax modem.

For more information about installing the Windows operating system Fax Service component, see Installing the Window Fax Services component.

Upgrade to the latest version of Adobe Reader

Adobe Reader supports faxing from Windows. To fax from Sage 100 Contractor, you should download and install the latest version from http://get.adobe.com/reader/.

Disable automatic updating for Adobe Reader

If you are using the scheduling capability for sending faxes, we recommend that you disable the automatic “check for updates” capability of Acrobat Reader as it will prevent scheduled reports from completing.

**NOTE:** Instructions for disabling automatic “check for updates” differ from version to version of Adobe Reader. Refer to the Adobe Reader Help for instructions.

Report Scheduling and Email Functionality

**IMPORTANT:** Using the email capability of Sage 100 Contractor requires Microsoft Outlook or access to a simple mail transfer protocol (SMTP) email server.

The Email Settings window provides a way for you to set up email. You can change the selections to accommodate different emailing preferences.

You can access the Email Settings window through:

- Any Report Printing window by clicking the Email button on the toolbar to open the Email Distribution windows. Then, click the Email Settings button to open the Email Settings window.
- **7-9 Alerts Manager**
- Click on Settings in the Dispatch Board, then click on Email Setup.

Sage 100 Contractor and SMTP

**IMPORTANT:** The SMTP server may be located on your workstation PC, on a server on your company’s network, or at your Internet service provider (ISP). If the email server is local, you may need the assistance of an IT professional to properly identify or set up this capability. If the email server is located at your ISP, you may need contact your ISP for assistance.
Using the ISP’s simple mail transfer protocol (SMTP) server to send email via Sage 100 Contractor typically requires “user authentication” at the STMP server. An example of an SMTP email server name is smtp.att.sbcglobal.net.

Different ISPs may use different terms when referring to user authentication. In general, however, user authentication means verifying a user’s identity by means of a “user name” and “password.”

In the context of sending email through Sage 100 Contractor using an ISP’s SMTP server, user authentication only refers to verifying the user’s identity at the ISP’s SMTP server. It does not refer to your:

- Sage 100 Contractor user name and password
- Network domain user name and password
- Windows system user name and password.

**NOTE:** We do not provide support for setting up or installing an email server. You set up user authentication and your fax line access dial out number on **7-2 Company Information**.

**Installing the Windows Fax Services component**

To fax from Sage 100 Contractor, you must install the Windows Fax Services component:

**Vista:**

1. Click **Start > Control Panel > Programs > Turn Windows features on or off.**
2. On the **Windows Features** window, locate the **Windows fax and scan** check box, then select it.
3. Click **[OK]**.

**Windows 7:**

1. Click **Start > Control Panel > Programs > Turn Windows features on or off.**
2. On the **Windows Features** window, locate **Print and Document Services**, then click on the **Windows fax and scan** check box.
3. Click **[OK]**.

**Windows 8:**

1. Click **Start > All apps > Control Panel > Programs > Turn Windows features on or off.**
2. On the **Windows Features** window, locate **Print and Document Services**, then click on the **Windows fax and scan** check box.
3. Click **[OK]**.

**Windows Server 2012**

[Detailed information from Microsoft](#)

**Sage 100 Contractor API**

**System requirements for Sage 100 Contractor API**

If you are using the Sage 100 Contractor API, the minimum and recommended system requirements may vary. These requirements must be considered in addition to the recommended system requirements for running Sage 100 Contractor.
It may be necessary to increase the processor speed, memory and/or disk space of your system depending upon the requirements of the third-party application using the API. Please consult with your third-party vendor to determine what changes, if any, should be made to your hardware configuration in order to meet your desired performance criteria.
Chapter 3: Sage 100 Contractor Installation

This chapter provides detailed information and instructions for installing Sage 100 Contractor software in different environments, such as:

- Single user
- Peer-to-peer
- Network

Installation Preview

Pre-installation information for new customers

Implementing and running your business in Sage 100 Contractor must be thoroughly planned out in advance to harness the power of this software. Your existing company data must be migrated before you start working in the program. Your business partner can assist you with a data migration and business implementation plan. For more information about implementing Sage 100 Contractor for your company, see the information about business partners in Chapter 1 of this guide.

We recommend that you take full advantage of all the knowledge and advice found in Sage 100 Contractor documentation and training classes. We also recommend that you work with your business partner and accounting professionals before you begin to implement this software for your business.

**IMPORTANT:** We recommend that you install the Sage license server on a computer that is always available to other computers on your network that are running Sage 100 Contractor.

Pre-installation information for existing customers

Because existing customers are working with company information and possibly with scheduled reports, please review these important points before you install the program.

**NOTE:** Before you install, make at least one backup copy, but consider making two backup copies of your existing company data for an extra margin of safety.

Upgrade Paths

<table>
<thead>
<tr>
<th>Upgrade From</th>
<th>Upgrade Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.x</td>
<td>Upgrade directly to version 19.x</td>
</tr>
<tr>
<td>17.x</td>
<td>Upgrade to 18.x, reindex your data, and then upgrade to 19.x</td>
</tr>
<tr>
<td>16.x</td>
<td>Upgrade to 18.x, reindex your data, and then upgrade to 19.x</td>
</tr>
</tbody>
</table>
### Upgrade From | Upgrade Path
--- | ---
15.x | Upgrade to 18.x, reindex your data, and then upgrade to 19.x
14.x | Upgrade to 18.x, reindex your data, and then upgrade to 19.x
13.x | Upgrade to 14.x, reindex your data, and then upgrade to 19.x
12.x | Upgrade to 13.x, reindex your data, and then upgrade to 19.x
11.x | Upgrade to 13.x, reindex your data, and then upgrade to 19.x
10.x | Upgrade to 13.x, reindex your data, and then upgrade to 19.x

### Duration of the installation process
Plan on at least five and possibly up to 20 minutes per computer to install Sage 100 Contractor. The duration of the Sage 100 Contractor installation depends a great deal upon each computer’s configuration. For example, some newer computers are pre-installed with essential software required to run Sage 100 Contractor software such as the .NET Framework 3.5 Service Pack 1. Installation to older computers may take more time.

### Additional required software
Microsoft .NET Framework 4.0 must be installed on all computers running Sage 100 Contractor software. The installer determines if the .NET Framework 4.0 is already installed. If not, the installer installs the required software automatically.

Plan for an additional 20 minutes per computer to install .NET Framework 4.0.

**NOTE:** It is very important that you understand the network environments and operating systems on the computers and server computers where you install Sage 100 Contractor software. For detailed information about installing to different environments, see [Special Configurations - Operating Systems and Services](#).

### About installing the Sage 100 Contractor software to different configurations
You can install Sage 100 Contractor software to many different configurations, for example, stand-alone, network server, Citrix and Terminal Services servers, peer-to-peer, and workstations.

**IMPORTANT:** The optimal operational size of a peer-to-peer network running Sage 100 Contractor is two to five workstations. Additional workstations may adversely impact Sage 100 Contractor response times. Networks consisting of more than five (5) workstations may need to use one computer as a dedicated server.

Sage 100 Contractor allows users to share data and reports stored on a network hard drive. From different workstations, users can then access the server to share one set of data, one set of reports, and one set of report forms.

During installation, the installer checks for the components necessary to run Sage 100 Contractor and then copies the program modules and standard reports to the **Programs (x86)** folder and subfolders on the hard disk. In addition, the installation process copies system files necessary for program operations to the Windows and Windows System folders.

The installation process does not make any configuration changes to the computer. After installation is complete, you must configure the stand-alone computer, server computer, or workstation for optimal performance.
For detailed information about configuring each server and workstation depending on its operating system, see Chapter 8 Special Configurations—Operating Systems and Services.

**Connectivity across your network**

For client workstations to be able to run Sage 100 Contractor, they must all be connected to the Sage license server. If one user sees the “Sage 100 Contractor can’t communicate with the designated Sage license server” message when all other people are connected, then you know that the connectivity problem is limited to that one person. If you encounter a hardware failure with your license server, then no one will be able to run Sage 100 Contractor.

**Mapping a network drive to access a company**

You may have to map to a network drive to access a Sage 100 Contractor company if it is not located on a drive on your local computer. Let’s suppose that the company has been moved to network drive Z: Now to access the company data, you have to map to drive Z.

**To map a network drive to access a company:**

1. On your Windows desktop, click **[Start > Explore]**.
2. On the tool bar, click **[Tools > Map Network Drive]**.
3. On the Map Network Drive window, click **[Browse]**.
4. Locate the drive, and then click **[OK]**.
5. On the Map Network Drive window, click **[Finish]**.
6. On the Company List window, select drive Z.
7. Select the company, and click **[OK]**.

**Installing the Sample Company**

The Sample Company provides the means for viewing and working with sample data in Sage 100 Contractor windows. There are sample accounts, sample employees, sample takeoffs, and much more. By viewing and working with this sample data, you can gain an understanding of how different windows interact with the sample data when managing a construction business with Sage 100 Contractor.

Sage 100 Contractor master trainers use the Sample Company extensively during Sage 100 Contractor training classes. We highly recommend that you load the Sample Company during your initial installation.

You can log on to the Sample Company using “Supervisor” as the user name. You do not need a password.

The Sample Company:

- Allows you a safe way to try out new functions as you learn them.
- Is used in many online and recorded classes.
- Provides samples of many Sage 100 Contractor forms that are all filled in. This makes it easy to understand many concepts.
- Provides starter lists for many values you’ll need to set up: cost codes, cost types, tasks, client status, client type, employee positions, paygroups, and so on.
- Provides you with live data to investigate the content of Sage 100 Contractor reports.
- Takes very little space on your hard disk drive.
Installing the Sample Company overwrites any previous installations of the Sample Company. If you have made changes in your Sample Company that you want to keep, rename this folder before installing a fresh copy of the Sample Company.

**New Installations**

A new installation is defined as installing the software on a computer that has never had Sage 100 Contractor installed on it before.

![NOTE:](image) Instructions for reinstallation/upgrade installation over an existing installation are different. See Upgrade Pre-installation.

You must designate one computer on your network as the Sage license server. This server will manage use of Sage 100 Contractor; for example, the number of people who can use Sage 100 Contractor simultaneously on your network. You will need to install the software on this computer first and then activate your licenses before installing Sage 100 Contractor on your other computers.

Copy the entire CD (all files and folder) to a folder that you create on a network drive and then install to each client workstation by launching the installation from that network folder from that client workstation. We recommend that you install to the Sage license server computer first. Then when you install the program to your workstations, you can set up Sage 100 Contractor to find the Sage license server and run the program using your license.

The installation process also presents different installation windows depending on whether you are installing Sage 100 Contractor as the Sage license server or you are just installing Sage 100 Contractor by itself.

**Basic steps for new installations are:**

1. First install the program on your network server, the computer where all your company data is located. You do this only once on your network. Remember to write down the Sage license server computer’s IP Address and/or computer name, which is displayed at the end of the installation.

2. Next, activate your licenses.

3. Install the program to all client workstations on your network.

4. From each client workstation, specify the Sage license server.

![IMPORTANT:](image) Always start installing the program at the computer that will be your Sage license server, which is likely to be your network server.

**Installing Sage 100 Contractor on the Sage license server**

Use these instructions when installing the software on the computer you’ll use as the Sage license server or if you are running in a stand-alone environment. Stand-alone means that you are running Sage 100 Contractor on one computer, or you are not networking with other computers running Sage 100 Contractor.

**To install from a download package unzipped into a local or shared folder:**

1. Close all open programs except for firewall and anti-virus programs.

2. Browse to the drive and folder where you downloaded and extracted the software package.

3. In the folder, locate the setup.exe file, and then double-click it.

4. On the installation option window, select the option This computer will be my Sage license server, and then click [Next].

5. On the license agreement window, read the License Agreement carefully.

6. Select the check box to accept the terms, then click [Next] to continue the installation.
On the select product edition window, specify whether to install the US or Canada edition.

On the select additional options window, select the option **Install the Sample Company for training purposes**. We recommend that you install the Sample Company.

Click **[Install]**.

**NOTE:** The installer begins the installation process. It checks to see if the computer has .NET Framework 4.0 installed. If this program is not found, the installer installs it.

At the end of the installation process, a confirmation window appears containing a list of installed programs.

- Sage 100 Contractor
- License Administration for Sage 100 Contractor

This window also displays the computer’s IP Address and its network name. You will use this information to specify the Sage license server.

Review the list of installed programs, and write down the IP Address and network name of the computer.

**IMPORTANT:** Write down and keep the Sage license server computer’s IP Address and name in a convenient location. To select the Sage license server from client computers running Sage 100 Contractor, you need to select its name from a list or type the computer’s IP Address or name in a text box.

Click **[Next]**.

The activate your product licenses window appears. The **Launch the License Administration program** check box is pre-selected to launch the License Administration program, so you can activate your licenses.

Read the instructions about activating your product licenses, and then click **[Finish]**, leaving the **Launch the License Administration program** check box selected.

**NOTE:** For information about this process, press F1 on the main License Administration window.

When Sage 100 Contractor is installed, an icon labeled License Administration is placed in the **Start > Programs > Sage 100 Contractor** menu of Windows and a file named Sage.SMB.LicenseAdministration.exe in the **Programs (x86)\Sage\Sage 100 Contractor** folder to provide you with the convenience and ability to view license information or update license information for your provisioned license server while on a machine other than the provisioned license server. You can provision additional licenses you have recently acquired to the actual license server machine without having to be present at the actual license server.

### Installing Sage 100 Contractor on client workstations

**NOTE:** If the install program does not start automatically, go to **Start > Run > Browse**. Locate your CD drive or CD image folder, select setup.exe, and then click OK. If your computer security warns you that Sage Licensing is trying to access the Internet, click Allow.

To install Sage 100 Contractor only from a download package unzipped into a local or shared folder:

1. Close all open programs except for firewall and anti-virus programs.
2. Browse to the drive and folder where you downloaded and extracted the software package.
3. In the folder, locate the setup.exe file and double-click it.
4. Read the instructions on the installation welcome window, and click **[Next]**.
5. On the installation option window, select the option **This computer will run Sage 100 Contractor only**, and click **[Next]**.
6. On the license agreement window, read the License Agreement carefully.
7. Select the check box to accept the terms, then click **[Next]** to continue the installation.
8 The select a drive window appears.

9 Select a local drive location for the installation, and click [Next].

10 The installer begins the installation process. It checks to see if the computer has .NET Framework 4.0. If this program is not found, the installer installs it.

11 Install the Sample Company for training purposes. We recommend that you install the Sample Company.

12 An installation complete window appears. The Launch Sage 100 Contractor check box is preselected so that you can launch Sage 100 Contractor and specify the Sage license server.

13 Read the important message and follow the instructions to launch Sage 100 Contractor.

14 Click [Finish].

15 Sage 100 Contractor begins its launch process by displaying the Specify Sage License Server window.

![NOTE: When Sage 100 Contractor in installed, an icon labeled License Administration is placed in the Start > Programs > Sage 100 Contractor menu of Windows and a file named Sage.SMB.LicenseAdministration.exe in the \Program Files (or Program Files (x86))\Sage\Sage 100 Contractor folder to provide you with the convenience and ability to view license information or update license information for your provisioned license server while on a machine other than the provisioned license server. You can provision additional licenses you have recently acquired to the actual license server machine without having to be present at the actual license server.]

Upgrade Installations

If you currently have Sage 100 Contractor installed on your network computers and you are going to reinstall it, you could be either upgrading or updating the software.

Upgrade installations involve major changes, enhancements, and fixes to many parts of the program or to modules such as licensing. For example, installing Version 19 over Version 18 is an upgrade installation because there are major enhancements to the program.

Update installations, in contrast, usually involve changes to specific files, such as the Sage.SMB.PayrollTax.dll file and report forms. These files can be changed and updated without any changes to major parts of the program.

In addition, upgrade installations are different from new installations. During new installations (or reinstallation after completely removing Sage 100 Contractor and Sage licensing), you can designate a computer to be either the Sage license server or a client workstation.

Upgrade Pre-installation

Upgrading your Sage 100 Contractor software requires that you complete preliminary tasks to ensure the safety of your company data.

When upgrading, it is important that you choose a block of time when you can install the upgrade to all the computers in your office beginning with your Sage license server. Depending on your computer's hardware and your network configuration, plan on 15 minutes per computer for the installation process alone. Additional tasks may take extra time.

The following are steps to take before upgrading Sage 100 Contractor:

1 Make two backups of your company data. We suggest making two backups in case one of them is incomplete, becomes corrupted, or is lost.

2 Exit Sage 100 Contractor and all other programs—You must not install the Sage 100 Contractor upgrade when either Sage 100 Contractor or the Sage 100 Contractor API are running. We recommend that you shut down all other programs when installing Sage 100 Contractor, but you do not have to shut down firewall and anti-virus software.
3 Locate the computer on your network that is your Sage license server, and begin the upgrade installation there.

Upgrade Installation

Always begin all installations at the computer that is the Sage license server. After installing the upgrade to the Sage license server, install the upgrade to your workstations from the image placed in a folder on the network. For example, if you want to install Sage 100 Contractor to a network drive, you have to go to that computer and install the program from there.

Sage 100 Contractor running on client workstations needs to connect to the Sage license server to access your company data. If you do not change the designation of any computers on your network during an upgrade installation, all client workstations will be able to locate the existing Sage license server again after installation.

Installing the upgrade

When installing, use the same upgrade installation steps for both your Sage license server and your workstation computers.

**IMPORTANT:** Install the upgrade to the existing Sage license server computer first. Install the upgrade to all workstations only after the license server installation has been completed.

To install the upgrade from a download package unzipped into a local or shared folder:

1 Shut down Sage 100 Contractor and all open programs except for firewall and antivirus programs.
2 Browse to the drive and folder where you extracted the upgrade files in the steps above.
3 Before you proceed further with installation, we recommend that you double-click the ReleaseNotes.pdf to open it in your PDF viewer. It's a good idea to review the Release Notes for information about “Enhancements,” “Fixes,” and “Known issues and Comments” that might apply to your network configuration and/or operating systems and affect your upgrade installation.
4 Double-click Setup.exe to begin the installation.
   a If you get a message asking if you want to allow the following program to make changes to this computer, click [Yes].
5 On the welcome window, notice that a previous installation has been found, and click [Next].
6 On the installation option window, select an option, and click [Next]:
   a This computer will be my Sage license server
   b This computer will run Sage 100 Contractor only
7 On license agreement window, read the license agreement carefully.
8 Select the check box to accept the terms, and then click [Next].
9 On the select additional options window, select the option to install the Sample Company. We recommend that you install the Sample Company, which is used extensively in Sage 100 Contractor training classes.

**IMPORTANT:** The upgrade installation overwrites the existing Sample Company. If you want to save changes to the existing Sample Company, clear the check box. If you do not overwrite the Sample Company, you must rebuild the indexes in the Sample Company database using 7-4 Rebuild Indexes after the upgrade installation. If you have made changes in your Sample Company that you want to keep, rename this folder before installing a fresh copy of the Sample Company.
10 Click [Next]. The installation proceeds.
11 On the Installation complete window, click [Finish] to launch Sage 100 Contractor.
12 Repeat steps to upgrade all other computers running Sage 100 Contractor.
13 Follow the instructions for post-installation tasks to rebuild the indexes your company database from one computer and reschedule your reports, as necessary.

**Uninstalling Sage 100 Contractor from a Sage license server**

When Sage 100 Contractor is uninstalled from an active license server, the server’s licenses are deauthorized and made available to be acquired by another license server. If the Sage license server crashes and the licenses are not deauthorized, contact [Customer Support](#) to have the licenses unlocked.

If uninstalling and then reinstalling to a Sage license server, the licenses need to be [reactivated](#) after reinstallation.

**NOTE:** Sage 100 Contractor implemented the current License Administration program with Version 18.1. Any version of Sage 100 Contractor earlier than 18.1 is using a different license administration program.
Chapter 4: ACT! Plug-in Installation

This chapter provides information and instructions for installing the ACT! plug-in for use with Sage 100 Contractor.

Pre-installation information

For Sage 100 Contractor to integrate with ACT!, the following requirements must be met:

- Sage 100 Contractor 2013 Version 18.1 or later must be installed
- ACT! Premium or ACT! PRO (version 2011 or later) must be installed
- ACT! plug-in license use must be obtained

Duration of the installation process

Plan on at least five to ten minutes per computer to install the ACT! plug-in. The duration of the Sage 100 Contractor installation depends a great deal upon each computer's configuration. Installation to older computers may take more time.

Additional required software

ACT! Premium or ACT! PRO (version 2011 or later) must be installed on all computers running Sage 100 Contractor software that use the ACT! plug-in.

Plan for an additional 10 to 15 minutes per computer to install ACT! Premium or ACT! PRO.

**NOTE:** It is very important that you understand the network environments and operating systems on the computers and server computers where you install Sage 100 Contractor software. Chapter 6 Special Configurations provides detailed information about installing to different environments.

Installing the ACT! Plug-in

Basic steps for installation are:

1. Verify Sage 100 Contractor and ACT! Premium or ACT! Pro (version 2011 and later) are already installed.
2. Activate your ACT! plug-in license.
3. Install the ACT! plug-in on any client workstations where you use ACT!.

Installation of Sage 100 Contractor and ACT!

To install Sage 100 Contractor, refer to Chapter 3: Sage 100 Contractor Installation in this guide.

To install ACT!, refer to the installation instructions that came with ACT! Premium or ACT! PRO (version 2011 or later) and see the ACT! Getting Started Resource Center at [http://na.sage.com/Sage-ACT/support/Getting-Started](http://na.sage.com/Sage-ACT/support/Getting-Started).
Activate your ACT! plug-in license use

To activate your ACT! plug-in license, refer to Chapter 6: Managing Your License in this guide.

To install the ACT! plug-in on client workstations:

1. Close all open programs except for firewall and antivirus programs.
2. Browse to the drive containing Sage 100 Contractor (for example, Programs (x86) > Sage > Sage 100 Contractor).
3. Double-click ACTPluginSetup.exe to begin the installation.
4. On the welcome window, click [Next].
5. On the Installation complete window, click [Finish].
6. Restart your computer as necessary.
Chapter 5: Sage Construction Anywhere Installation

This chapter provides information about setting up Sage 100 Contractor for use with Sage Construction Anywhere.

Additional required software

- The Sage Construction Anywhere Connector should be installed on at least one computer running Sage 100 Contractor software that connect to Sage Construction Anywhere, but can also be installed to a separate server. See the "Installing the Sage Construction Anywhere Connector Software section in the Getting Started Guide at http://help.sageconstructionanywhere.com/docs/Default.htm. The Sage Construction Anywhere Connector connects your back office software to your Sage Construction Anywhere site. The connector installation includes the Sage Construction Anywhere Connector software and its required prerequisite software.


NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.

Duration of the installation process

Plan on at least five to ten minutes per computer to install the Sage Construction Anywhere Connector software. The duration of the Sage 100 Contractor installation depends a great deal upon each computer’s configuration. Installation to older computers may take more time.

Pre-installation information

In order for Sage 100 Contractor to integrate with Sage Construction Anywhere, the following programs must be installed and set up:

- Sage 100 Contractor 2013 Version 18.3 or later must be installed
- Supported version of Sage Construction Anywhere

For more information on Sage Construction Anywhere and the Sage software versions supported, do the following:

2. Click on the Getting Started Guide link.
3. View Appendix A: System Requirements for the currently supported software versions.

Setting up Sage Construction Anywhere Integration

In order for Sage 100 Contractor to integrate with Sage Construction Anywhere, the following programs must be installed and set up:
- Sage 100 Contractor 2013 Version 18.3 or later must be installed
- Supported version of Sage Construction Anywhere

In addition, an API user needs to be set up for any companies that are to be integrated.

- In Sage 100 Contractor, in **7-3-1 Security Groups**, an API security group must exist with the appropriate save permissions. See [See "Setting up an API security group and an API user in Sage 100 Contractor"](#) to set up the API group.
- In Sage 100 Contractor, in **7-3-2 User List**, a user that is a member of the API group must be set up.

### Setting up an API security group and an API user in Sage 100 Contractor

Security groups let you control users’ ability to open windows as well as perform specific actions within a window. The **7-3-1 Security Groups** window in Sage 100 Contractor contains a grid with numbered rows on the left and eight columns:

- Group# (User input is required to save the record.)
- Group Name (User input is required to save the record.)
- Save
- Delete
- Void
- Chg Period
- Print Checks
- Notes

When you set up user groups, you type a group number and group name. Then you determine whether or not that group will have rights to **Save**, **Delete**, and **Void** records, as well as to change the accounting period and print checks. You may use the Notes column to add any pertinent information about each group.

You must create an API security group that is named exactly **API**. At least one user must be added to the API security group. You have to set rights to save, void, and so on.

**IMPORTANT**: If you use security groups for the tasks performed by the employee in Sage 100 Contractor, make sure the Sage Construction Anywhere user has access to all areas of Sage 100 Contractor.

To set up a security group for using the API

1. Open **7-3-1 Security Groups**.
2. In the **Group#** cell, type a group number, such as 51.
3. In the **Group Name** cell, type API and do the following:

   **IMPORTANT**: The API security group must be named exactly **API**.

   a. In the **Save**, **Delete**, **Void**, **Chg Period**, and **Print Checks** cells, type **Yes**.
   b. To store information that may be relevant or important to that specific group, type a note in the **Notes** cell.
4. On the **File** menu, click **Save**.
TIPS:

- Before you can use the API security group to access Sage 100 Contractor company data, you have to assign a user to the API security group.
- Security is set up for each individual company, not for the entire program. Each company can use different user names and passwords. If you have more than one company, you have to set up passwords for multiple companies.

Then you have to assign a user to the API security group using **7-3-2 User List**.

The **7-3-2 User List** window controls major features dealing with users and program security.

**NOTE:** The user name and password created are for administrative use only. This information is for use by the Sage Construction Anywhere Connector program only, and is not needed by the individual employee(s) using Sage Construction Anywhere.

To assign a new user to the API security group

1. Open **7-3-2 User List**.
2. In the **User Name** cell, enter a user name, such as SCAUser.
3. In the **Password** cell, enter a password.
4. In the **Group 1** cell, click once in the cell, and from the drop-down list, select the API group.
5. Click **File > Save**.

**IMPORTANT:** The API will not accept "supervisor" as a user name.

To assign an existing user to the API security group

1. Open **7-3-2 User List**.
2. Find the **User Name** for the person who will use Sage Construction Anywhere.
3. In the **Group 1**, **Group 2**, **Group 3**, **Group 4**, or **Group 5** cell, click once in the cell, and from the drop-down list, select the API group.
4. Click **File > Save**.
Chapter 6: Managing Your License

This chapter provides detailed information about:

- Managing and activating your license
- Using License Administration

License Administration

When you purchase Sage 100 Contractor software, it includes the License Administration program. Using the License Administration program, you can activate licenses and monitor the license uses. During software installation, the License Administration program is automatically installed on the computer that the software installer designates as the Sage license server.

**IMPORTANT:** Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on your network that is the Sage license server when you launch Sage 100 Contractor.

Where is the Sage license server located?

The Sage license server is software running on a computer on your network that manages the Sage 100 Contractor products and features that you purchased. Products and features can be a “core product,” additional “modules,” and a number of “license uses.” The computers running your Sage 100 Contractor have to be connected to the computer running the Sage license server so that the correct products, features, and number of license uses are available to you.

Which versions of Sage 100 Contractor use License Administration?

Sage 100 Contractor implemented the current License Administration program with Version 18.1. Any version of Sage 100 Contractor earlier than 18.1 will not work with the License Administration program described in this chapter.

License Administration window

Use the License Administration window to view and maintain your licensing information. This includes the number of license uses, the users who are logged on to Sage 100 Contractor, and licensing events.

Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license server automatically updates this information in your system. You can also select to update the licensing information from Sage on demand.

About managing licenses

Use the License Administration window to activate licenses and monitor license uses.

Activating licenses

In order to use Sage 100 Contractor, you have to activate your product licenses.
To activate your license:
1 On the License Administration window, click the **Edit registration info** link.
2 Enter your **Sage client ID**.
3 Enter your **Registration name**.
4 Click **[OK]**.

**License Information tab**

The tab, which is available from the *License Administration window*, displays information about your Sage 100 Contractor licenses.

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support plan expiration date</td>
<td>The date on which your support plan with Sage Customer Support expires.</td>
</tr>
<tr>
<td>Number of requests which exceeded use count (last 90 days)</td>
<td>Displays the number of times the request for licenses failed in the past three months because there were not enough licenses available. If there are a significant number of requests, you may want to acquire additional licenses.</td>
</tr>
<tr>
<td>Last license information update</td>
<td>The last date upon which your licenses were verified with Sage's license server. <strong>NOTE:</strong> If your system cannot connect to Sage for a period of more than 10 days, you will receive a message indicating there is a connection problem. See <a href="#">Troubleshooting license activation issues</a> for more information.</td>
</tr>
</tbody>
</table>
| Licensed modules                          | Displays a list of licenses available to this server, based on the products you have purchased from Sage. When you purchase new products, the licenses for those products become available to activate here. "US Edition" refers to the basic program, exclusive of the additional modules. The module licenses that are not part of the core US Edition, but are available for purchase, are listed here:  
  - Inventory  
  - Service Receivables  
  - Estimating  
  - Document Control  
  - Equipment Management  
  There is also a column that shows how many US Edition licenses are checked out from this license server to local machines. |
<p>| Update license information                | Click to update the license information manually. This connects your server to the Sage license server, where your current license information is stored, and it updates the information on this window. This also creates entries in the <em>event log</em>. View the event log to monitor the success of your license activations. <strong>NOTE:</strong> If you are using multi-server license administration, ensure you have the proper allocations set under <em>Multi-server licensing</em> before you update your license information. |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deauthorize license server</td>
<td>Typically, this would be used if you are moving Sage 100 Contractor's license server from one machine to another machine.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT:</strong> You need to deauthorize the old server in the <strong>License Information</strong> tab before you authorize Sage 100 Contractor's license server on a new server.</td>
</tr>
<tr>
<td>Multi-server licensing</td>
<td>This allows you to allocate your Sage licenses to multiple servers. For example, this could happen if you have several corporate offices and want to use separate licenses for each office or if you want to reserve a certain quantity of license uses for a specific group of people.</td>
</tr>
</tbody>
</table>

**Active Users tab**

This tab of the **License Administration window** lists the names of all users and computers currently using Sage 100 Contractor.

Each row in the list represents a separate license use. If you find you are running out of licenses, you can review this list to determine if any licenses can be made available. To make a license available, simply close Sage 100 Contractor on one of the computers where the program is running.

You can restrict all users from logging on to the Sage 100 Contractor software from this tab.

**Items on this tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The name of the user who is currently logged on to Sage 100 Contractor.</td>
</tr>
<tr>
<td>Computer</td>
<td>The computer where the user is logged on to Sage 100 Contractor.</td>
</tr>
<tr>
<td>Session</td>
<td>The Windows session for the user.</td>
</tr>
<tr>
<td>Restrict logon/Allow logon</td>
<td>Click <strong>Restrict logon</strong> to prevent users from logging on to Sage 100 Contractor temporarily. This prevents new users from logging on to Sage 100 Contractor but does not remove existing users. You might use this feature in preparation for backing up your database, for example.</td>
</tr>
<tr>
<td></td>
<td>If you have previously restricted logon, click <strong>Allow logon</strong> to allow users to log on to Sage 100 Contractor.</td>
</tr>
</tbody>
</table>

**Event log tab**

Use this tab of the **License Administration window** to view events related to licensing. This lists whether license validation was successful or if there were any problems attempting to validate the licenses. See **Troubleshooting license activation issues** for more information about issues validating licenses.

**Items on this tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level</td>
<td>The level of the licensing event (for example, informational).</td>
</tr>
<tr>
<td>Date and time</td>
<td>The date and time that the licensing event occurred.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the licensing event. Typically, this displays &quot;Entitlements updated for client,&quot; but this will also indicate if there was a problem updating the licenses. The section below this area provides additional details about the issue.</td>
</tr>
<tr>
<td>Item</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Clear event log</td>
<td>Click to remove all entries in the list.</td>
</tr>
</tbody>
</table>

## Maintaining License Information

Your Sage 100 Contractor software automatically retrieves license information from Sage every day. The licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license server automatically updates this information in your system. You can also select to update the licensing information manually.

![NOTE:](image) Licenses are granted to the specific computer where the licenses were initially activated. If you need to move your Sage 100 Contractor server to a different server, you must first deactivate the licenses in the **License Information** tab on the old server before you can activate them on a new server.

### To view or change license information:

1. Select **License Administration** program.
2. You can view or change the information here, or you can click **Update license information** to retrieve current licensing information from Sage. Note that the Sage client ID and Registration name must match Sage’s records exactly in order for the update to be successful. To change the Sage client ID or the registration name, select **Edit registration information**.

![NOTE:](image) If you have multiple servers serving your Sage 100 Contractor application, click **Multi-Server License Administration** to allocate and update your licenses.

3. To view which users are logged on to Sage 100 Contractor, click the **Active users** tab.
4. To view the results of the previous update attempts, click **Event log**. Click **Clear event log** if you no longer need the information.

![TIP:](image) For more information, click 📌 while viewing the window.

## Multi-Server License Administration window

For most users of Sage 100 Contractor, it is not necessary to allocate license across multiple servers.

If you need to allocate licenses across multiple servers, this window allows you to allocate your Sage licenses to multiple servers. For example, this could happen if you have several corporate offices and want to use separate licenses for each office or if you want to reserve a certain quantity of licenses for a specific group of people.

Because the US Edition license controls the amount of license uses, it is the only license which is “use-counted.” Therefore the only license that is allocated among multiple servers is the US Edition license. The additional modules are not use-based and can be used by anyone with a core US Edition license and the appropriate security permission.

### Example 1—Multiple servers with specific allocations

Assume you have three servers that you want to allocate as follows:

<table>
<thead>
<tr>
<th>Server</th>
<th>Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server A</td>
<td>3 US Edition licenses</td>
</tr>
<tr>
<td>Server B</td>
<td>3 US Edition licenses</td>
</tr>
</tbody>
</table>
At each of the servers, you would select the **Manually specify allocations for this server** option in the Multi-Server License Administration window, and select the number of licenses for that server.

If you later purchase additional US Edition licenses, you must go into each server where you want the additional licenses to be allocated and update the allocation.

**Example 2—Multiple servers with specific allocations for all but one server**

Assume you have three servers that you want to allocate as follows:

<table>
<thead>
<tr>
<th>Server</th>
<th>Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server A</td>
<td>3 US Edition licenses</td>
</tr>
<tr>
<td>Server B</td>
<td>3 US Edition licenses</td>
</tr>
<tr>
<td>Server C</td>
<td>All remaining licenses</td>
</tr>
</tbody>
</table>

At servers A and B, select the **Manually specify allocations for this server** option in the Multi-Server License Administration window.

At server C, select the **Allocate all available licenses to this server** option in the Multi-Server License Administration window.

**NOTE:** In this example, it is important to select the option for server C last. If you select to automatically allocate all available licenses on server C first, it will take all the available licenses and there will be none left to allocate to servers A and B.

If you purchase additional licenses, they will automatically be allocated to server C when the license activations are updated, unless you manually select the licenses to go to server A or B first.

**Items on this window**

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allocate all available licenses to this server (default)</td>
<td>If you choose this option, all licenses are allocated to this server. This is the most common scenario. Do not choose this option if you want to allocate licenses across multiple servers.</td>
</tr>
<tr>
<td>Manually specify license allocations for this server in the &quot;Uses for [server name]&quot; column below</td>
<td>Select this option to allocate licenses across multiple servers. The amount of licenses you select in the <em>Uses for [server name]</em> column is the amount of licenses allocated to this server.</td>
</tr>
<tr>
<td>Item</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Module name  | Displays a list of licenses available to this server, based on the products you have purchased from Sage. When you purchase new products, the licenses for those products become available to activate here. "US Edition" refers to the basic program, exclusive of the additional modules. The module licenses that are not part of the core US Edition, but are available for purchase, are listed here:  
  - Inventory  
  - Service Receivables  
  - Estimating  
  - Document Control  
  - Equipment Management  
  There is also a column that shows how many US Edition licenses are checked out from this license server to local machines.                                                                                                                                 |
| Total uses   | The total number of uses that are available. This displays the total number of licenses you have purchased.                                                                                                                                                                                                                           |

<table>
<thead>
<tr>
<th>Item</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available uses</td>
<td>The number of uses available to this server. If some licenses have already been allocated to a different server, it reduces the number of uses available here. For example, if you have 10 total uses, and 2 have been allocated to another server, the available uses for this server is 8.</td>
</tr>
</tbody>
</table>
| Uses for [server name] | The number of uses allocated to this server. You can change the number here, but you can only add uses if there are still uses available. You can decrease uses to make more licenses available to other servers.  
  If you need to have more uses available to this server, you must first relinquish licenses on one of your other servers, or purchase additional licenses.                                                                                                               |
| [OK]         | Click to allocate the licenses selected in the Uses for [server name] column to this server.                                                                                                                                                                                                                                         |
| [Cancel]     | Click to cancel this window without making any changes.                                                                                                                                                                                                                                                                            |

To open this window, open the License Administration program and on the License Information tab, click [Multi-server licensing].

**Managing Licenses**

**Checking out and checking in a license use**

You can use Sage 100 Contractor when your computer cannot actively communicate with the license server, by checking out a license use from the Sage license server.

**NOTE:** Checking out a product license use removes it from the license server’s pool of generally available license uses and places it directly on the computer checking out the license. However, this may prevent other user access to Sage 100 Contractor, so checking out a license should only be used when necessary.
To check out a license use:
1 From the Sage 100 Contractor main window, on the File menu, click **Check Out License Use**.
2 Click **Yes**.

**IMPORTANT:** If you check out a license use, it remains checked out on this computer until you check in the license using **Check In License Use** from the File menu.

To check in a license use:
1 From the Sage 100 Contractor main window, on the File menu, click **Check In License Use**.
2 Click **Yes**.

**Administering a different license server**

In the License Administration program, you can see the number of license uses, the users who are logged on to Sage 100 Contractor, and licensing events for this license server.

Licenses are granted to the specific computer where the licenses were initially activated. If you need to see the license uses available on another Sage license server, you can do that in the License Administration window.

To administer a different license server:
1 Select the License Administration program.
2 From the License Administration window, click **Administer Different Server**.
3 Enter computer name or IP address. **How?**

**Troubleshooting License Issues**

**Troubleshooting license activation issues**

Your system will automatically retrieve license information from Sage daily. The licenses give you access to the various modules of Sage 100 Contractor. As you purchase or remove license activations, the Sage license activation server automatically updates this information in your system.

If the server that hosts Sage 100 Contractor is unable to connect to the Sage license server for more than 10 days, you will receive a message indicating there is a connection problem. The following are some of the more common issues that can cause this to occur.

**There is a problem with your Internet connection.**

The Sage 100 Contractor server connects to the Sage license server through the Internet. Check to make sure the server’s connection to the Internet is intact.

**There is a problem with your network.**

Any network issues that interrupt the Internet connection (such as firewall settings) can prevent the Sage 100 Contractor server from connecting to the Sage license server. Confirm that your firewall is configured correctly and that all network components are operating properly.

**The registration information does not match.**

The **Sage client ID** and **Registration Name** on the **License Administration window** must match the information on the Sage license server. Ensure the information is entered correctly here.
You have exceeded your license activations.

You do not have enough licenses to support everyone attempting to use Sage 100 Contractor. You may want to purchase more licenses.

**TIP:** The Number of requests which exceeded use count box on the License information tab of the License Administration window displays the number of times in the last three months that requests for licenses have exceeded the number of licenses available.
Chapter 7: License Use and Sage 100 Contractor

This chapter provides all the necessary details about:

- Specifying the Sage license server
- Managing license attributes
- Understanding license uses

Specify Sage License Server

What is a server?

There are many kinds of servers. Some servers are denoted by their hardware configuration and a specialized operating system. Other servers consist of specialized software applications running on standard computers.

Some servers are called “file servers” and may be a powerful computer dedicated to storing files and data. For example, Sage 100 Contractor company data can be stored on a file server. Any Sage 100 Contractor user on the same network as the file server can access and store data there.

A server can also be a software application that provides a specific kind of service to client software running on other computers. The term server can refer to a particular piece of software, such as the Sage license server. When we refer to the Sage license server, we are describing a computer that is running the Sage license server software.

Before you can use Sage 100 Contractor with your activated license, you have to specify the computer on your network that is the Sage license server. There are two ways to specify the Sage license server:

- You can select the computer from the list of computers on your network; or
- You can enter the IP Address or name of the computer.

Selecting the Sage license server computer

One method is to select the computer running the Sage license server from the list of network computers.

NOTE: To use this method of selecting a server from the list of network computers, you must have already clicked the appropriate link on the Specify Sage License Server window.

To select the computer running Sage license server from the list of network computers:

1. On the Select License Server window from the list of network computers, select the computer running the Sage license server.
2. Click [OK].
Entering the IP Address or name of the computer

One method is to enter the IP Address or name of the computer running the Sage license server.

To enter the IP Address or name of the computer running the Sage license server:
1 In the text box, type the IP Address or name of the computer.
2 Click [OK].

Determining the IP Address of a computer

NOTE: If you are trying to determine the IP Address computer running the Sage license server, you must complete this procedure on that computer.

To determine the IP Address of a computer:
1 Click Start > Run.
2 In the Open text box, type cmd, then click [OK].
3 The Windows\...\cmd.exe window appears.
4 At the prompt, type ipconfig.
5 For example, you might see H:\. Type ipconfig after the drive letter. When you press the Enter key, the system displays several addresses, among which is the IP Address of the computer. You see a line similar to this:

   IP Address . . . . . . 172.20.22.142

What is an IP Address?

Every computer connected to the Internet is assigned a unique number known as an Internet Protocol (IP) address. This numeric address of a computer on the Internet is written as a set of four numbers separated by periods (each number can range from 0 to 255). An example of an IP Address is 123.123.4.5.

Determining the name of a computer

NOTE: If you are trying to determine the name of the computer running the license server, you must complete this procedure on that computer.

To determine the name of a computer:
1 On your Windows desktop, click Start, Settings, and then Control Panel.
2 From the list, scroll to and double-click System.
3 The System Properties window appears.
4 Locate the line Full computer name, and write it down or type it into a note that you can print.
5 Click Cancel.
Chapter 8: Special Configurations—Operating Systems and Services

This chapter contains information about special configurations for specific operating systems, such as:

- Windows 8 Professional and Server 2012 Standard
- Windows® 7 Professional and Windows Server 2008® R2 Standard
- Windows Vista® and Windows Server 2008
- Citrix® and Terminal Servers

Windows 8 Professional and Server 2012 Standard Operating Systems

Windows 8 Professional and Server 2012 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 8 Professional or Server 2012 Standard operating system is used as a license server, when it goes into sleep mode other computers on the network can’t obtain a license.

To avoid this possibility, set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to "Never":

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 8

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 8 Professional or Windows 8 Enterprise operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

Solution for Server 2012 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2012, follow these steps to resolve the issue:

1. On the Window desktop, right-click Start, and then click [Explore].
2. On the left side of the window, under Folders, right-click the MB7 folder, and then select Properties.
4 From the list under Group or User Names, select USERS, then click the [Edit] button.

5 On the Permissions window, select USERS again, and under Allow, select the Full control check box.
   Selecting Full control, selects all the check boxes necessary for this solution.

6 On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].

Server 2012 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2012 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating Systems

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2 Standard "Sleep Mode" prevents computers from obtaining a license use

If a computer running the Windows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a license server, when it goes into sleep mode other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer to Never.

To set the Sleep Mode to “Never”:

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Windows 7 Professional and Server 2008 R2 Standard

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Windows 7 Professional or Server 2008 R2 Standard operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

Solution for Server 2008 R2 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2008 R2, follow these steps to resolve the issue:

1 On the Window desktop, right-click Start, and then click Open Windows Explorer.
2 On the left side of the window, under Computer > Local Disk, right-click the \MB7 folder, and then select Properties.
3 On the MB7 Properties window, click the Security tab.
4 From the list under Group or User Names, select USERS, then click the [Edit] button.
5 On the Permissions window, select USERS again, and under Allow, select the Full control check box.
   Selecting Full control, selects all the check boxes necessary for this solution.
6 On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].
Server 2008 R2 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File and printer sharing on computers running the Server 2008 R2 operating system must be enabled. To enable file sharing, follow the instructions in the Windows Server 2008 R2 Help.

Windows Server 2008 R2 and Microsoft .NET 3.5.1

Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on a Windows Server 2008 R2 machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the following message during the licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.” When you click [OK], the installation continues, but the services have not been installed so Sage 100 Contractor cannot open. The Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.

To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:

1. Click the Start button in the lower left corner of the display.
2. Highlight Administrative Tools and select Server Manager.
3. In the Server Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that .NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:

1. In the Server Manager interface, select Add Features to display a list of possible features.
2. In the Select Features interface, expand .NET Framework 3.5.1 Features.
3. Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET Framework 3.5.1 and click Next.
4. In the Confirm Installation Selections interface, review the selections and then click [Install].
5. Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1 may require a reboot.

Windows Vista and Server 2008 Operating Systems

Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license use

If you are using a Vista or Server 2008 computer as the Sage license server and it goes into Sleep Mode, the workstations cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in place of Vista or Server 2008.

Set Sleep Mode on your license server computer to Never.
To set the Sleep Mode to "Never":

2. Select Change when computer sleeps.
3. From the Put computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on Vista, Windows 7, Windows 8, or Server 2008

**IMPORTANT:** Read this information if you are running Vista or Server 2008 operating systems on your office computers.

The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the Vista, Windows 7, Windows 8, or Server 2008 operating systems. If the service stops, the program displays a message advising you to take further action to resolve this issue.

Solution for Server 2008 error message about mb7.kpr file

If you encounter an error message about opening the mb7.kpr file when launching Sage 100 Contractor on a computer running Windows Server 2008, follow these steps to resolve the issue:

1. On the Window desktop, right-click Start, and then click [Explore].
2. On the left side of the window, under Folders, right-click the MB7 folder, and then select Properties.
4. From the list under Group or User Names, select USERS, then click the [Edit] button.
5. On the Permissions window, select USERS again, and under Allow, select the Full control check box. Selecting Full control, selects all the check boxes necessary for this solution.
6. On the Permissions window, click [OK], and then on the MB7 Properties window, click [OK].

Vista, Windows 7, and Server 2008 network configuration and TCP Remoting Channel

Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication among computers on a network. File sharing on computers running the Vista, Windows 7, or Server 2008 operating system must be enabled. To enable file sharing, follow the instructions in the Vista, Windows 7, or Server 2008 Help.

Vista, Windows 7, and Server 2008 and changing the Sage License Server computer

On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the computer from the list of computers on your network, the command may fail to generate a list of network computer names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the server computer in the box.
Citrix and Terminal Servers

Using Citrix and Terminal Server with Sage 100 Contractor

Many people use Citrix and Terminal Server to manage remote access to their local area network (LAN). If Sage 100 Contractor is installed on the computer running Citrix or Terminal Server and on your laptop, then you may log on to the computer running Citrix or Terminal Server with your laptop and work in Sage 100 Contractor on your LAN. This enables you to work from home, from a job site, or from any number of other remote locations.

We recommend that you use DOS commands to change the operating mode from “execute” to “install” and then back to “execute.” When using the DOS commands to install, you may install the Sage 100 Contractor software as you would on any desktop or Windows server operating system that meets Sage 100 Contractor requirements.

Installing on computers running Citrix and Terminal Server using DOS commands

To install using DOS commands:

1  Click [Start], then [Run].
2  On the Run window, in the Open drop-down box, type cmd, and press the Enter key.
3  The \Windows\...\cmd.exe window appears.
4  At the prompt, type change user /install, and press the Enter key.
5  This enables the install mode.
6  Install the Sage 100 Contractor software as you would on a typical workstation or Windows Server.
7  At the end of the installation process, choose to launch the License Administration Tool.
8  Using the License Administration Tool window, manage your license and activate it.
9  After activation, click [Start], then [Run].
10 On the Run window, in the Open drop-down box, type cmd, and press the Enter key.
11 The \Windows\...\cmd.exe window appears.
12 At the prompt, type change user /execute.
13 This enables the execute mode, which is the default mode for running Citrix and Terminal Server.
14 Exit the Run window.
15 Restart the server.

*IMPORTANT*: If this message appears: “Install mode does not apply to a terminal server configured for remote administration,” then it is not necessary to enable the install mode. You may install the Sage 100 Contractor software as you would on a typical workstation.

Backing Up Your Data

With any computer system, there is the possibility for failure and loss of data.

*CAUTION*: Use a backup method and device suitable for your business requirements. We strongly recommend that you maintain a routine backup schedule and store your data in a safe environment that is separate from your server, preferably off site.
Which files to back up in Sage 100 Contractor

**NOTE:** This topic applies only to existing Sage 100 Contractor customers.

When you back up your company data, we recommend that you back up your company financial data as well as all your custom reports and forms. If you are running multiple Sage 100 Contractor companies, back all of them up.

When backing up data as part of the year-end close process, it is important to count the number of files and folders in your company.

To see the number of files and folder in a company folder, in Windows Explorer, right-click the company folder and select Properties. On the Properties window, the General tab, look in the list for the Contains line for the number of files and folders. Write this number down so that you can refer to it after you have made the two copies. The number of files and folders has to be exactly the same in both the company and the backup copy.

We strongly recommend that you back up:

- Each company folder that contains financial data (\MB7\Your Company)
- The **Sage 100 Contractor** folder (\Users\Username\AppData\Local\Sage\Sage 100 Contractor)
- The **Report Forms** folder (\MB7\Report Forms)
- The **Custom Reports** folder (\MB7\Custom Reports)

**IMPORTANT:** When backing up your data, be sure to make a full backup and not an incremental or differential backup. An incremental or differential backup only records alterations to the data since the last backup.

**An example of one backup method**

There are various methods for backing up your data. Depending on the amount of data entry you routinely perform, you might consider making full daily backups. It is also a good idea to regularly take one backup off the business premises or store them in a fireproof safe. If a burglary or fire occurs, a copy of your data is safe from harm.

One reliable procedure, requiring a tape drive and multiple sets of tapes, requires you to make daily and monthly backups.

**Daily Backup Process**

For the daily backup process, you need 10 tapes. Label five of the tapes as Week A, with a tape designated for each weekday. Label the other five tapes as Week B, with a tape designated for each weekday.

Start with the set of tapes labeled Week A. Monday night when you make the backup use the tape labeled Monday, on Tuesday use the tape labeled Tuesday, and so forth. At the start of the next week, use the set of tapes labeled Week B to make your backups. At the end of two weeks, you will have a data backup for each day. Then at the start of the third week, use the set of tapes labeled Week A again. Over the course of a year, you will cycle through the two sets of tapes. Be sure to store the most recent Friday backup off site.

**Monthly Backup Process**

For the monthly backups, you need a separate set of three tapes labeled Month A, Month B, and Month C respectively. Like the weekly backups, use each tape to back up the data for a different month, cycling through each of the tapes over the course of the year. After making a monthly backup, write the month and year on the label to help you track which tape to use next. Be sure to remove the most recent monthly backup off site.
Backing up your data to a CD or DVD

This topic suggests a generic way to back up your data to a CD or DVD. Backing up to a CD or DVD successfully depends on your computer system, including hardware and software. To back up to a CD or DVD, you must have access to a CD or DVD (Read/Write capability), and the appropriate CD or DVD media.

When backing up data as part of the year-end close process, it is important to count the number of files and folders in your company. To see the number of files and folder in a company folder, in Windows Explorer, right-click the company folder and select Properties. On the Properties window, the General tab, look in the list for the Contains line for the number of files and folders. Write this number down so that you can refer to it after you have made the two copies. The number of files and folders have to be exactly the same in both the company and the backup copy.

**IMPORTANT:** If you are working across a network, you must remember to backup company folders, report folders, and form folders that reside at the server.

To back up your data to a CD or DVD:

1. Place the CD or DVD media in the CD or DVD.
2. On your Windows desktop, right-click [Start > Explore].
3. In Windows Explorer, locate the \Users\Username\AppData\Local\Sage\Sage 100 Contractor folder, right-click and from the menu select [Copy].
4. Locate the CD or DVD drive, and click it.
5. Then in the right-pane, right-click and select [Paste].
6. In Windows Explorer, locate the \MB7\ folder, right-click and from the menu select [Copy].
7. Locate the CD or DVD drive, and click it.
8. Then in the right-pane, right-click and select [Paste].

Depending on your hardware and software, the folder will be copied to the CD or DVD media. For further information or support, contact your CD or DVD manufacturer.

Configuring Windows Regional and Short Date Format:

1. Click the [Start] button, point to Control Panel, then click Clock, Language, and Region.
2. Click Region and Language.
3. On the Formats tab, select English (United States).
4. Under Date and time formats, from the Short date format drop-down list, select MM/dd/yyyy.
5. Click [OK].
6. Close the Clock, Language, and Region window.
Index

.NET
  about install 13
  client workstation
    requirements 7, 14
  server requirements 14

A
  act 30
  ACT 30
  API
    system requirements 18
  autostart
    Windows 7/Server 2008 R2 43-44

B
  backup 20, 48-49
    backing up to CD or DVD 49
    daily backup process 48
    methods 48-49
    monthly backup process 48
    which files to backup 48
  browsers, supported 9

C
  Citrix servers 47
    DOS cmd installation 47
  client workstation
    .NET requirements 14
  company 22
    mapping a network drive to access 22
  computer name 42
    determine 42
    entering the computer name 42
  customer support
    knowledgebase 2

D
  date format 49
  document conventions 1
  DOS cmd installation
    Citrix servers 47
    Terminal servers 47

F
  fax service component
    Windows 18
  file server
    hardware 6
  firewall
    configure 10
  folder
    MB7 48
    Report Forms 48
  forms
    check 5
    tax 5
hardware 6
file server 6
install 20-22, 24, 28, 30
.NET 13
.NET framework 13
duration 21, 28, 30
installing on client workstations 24, 28
installing the Sample Company 22
pre-installation for existing customers 20
pre-installation for new customers 20
integration
Sage Construction Anywhere 30
Ip Address
what is an IPAddress 42
IP Address 42
determining the IPAddress 42
entering the IPAddress 42
language 49
License Administration 33
license server 33
change server computer 46
licenses 33
activating licenses 33
licensing
TCP Remoting Channel 10
methods 48
backup 48
Microsoft Office 9
supported versions 9
network 22
connectivity 22
network configuration 10
client and workstation 7, 10
licensing 10
server 9
network drive 22
mapping network drive 22
operating system
fax service component 18
operating systems
system requirements 8
Outlook 17
reports
faxing and emailing
setup 17
Sage 100 Contractor Hosting Framework 46
autostart 43-44, 46
Sage Construction Anywhere 30
setting up integration 30
setting up the API security group 31
setting up the API user and password 31

Sage CRE
  cheques 5
  forms 5

Sage license server 23, 33, 41
  installing the Sage license server 23
  managing licenses 33
  name 42
  selecting server computer 41

Sample Company 22
  installing 22

server 41
  network configuration 9

Server 2008
  change license server 46
  sleep mode 45
  TCP Remoting Channel 10

Server 2008 R2
  sleep mode 43-44
  TCP Remoting Channel 45

Server 2012
  TCP Remoting Channel 44

server hardware
  system requirements 6

server requirements
  .NET 14

simple mail transfer protocol 17

sleep mode
  Server 2008 45
  Server 2008 R2 43-44
  Vista 45

Windows 7 43-44

SMTP 17

software 21, 28, 30
  additional required software 21, 28, 30

special configuration
  Windows 7/Server 2008 R2
    autostart 43-44

system configuration
  language and date 49

system information
  viewing 14

system requirements
  API 18
  client hardware 7
  operating systems 6, 8
  server hardware 6
  web browser 9
  workstation hardware 7

TCP Remoting Channel
  licensing 10

Terminal servers 47
  DOS cmd installation 47

training 4
  getting started 5

upgrade 26
  installing the upgrade 26
Vista
  change license server 46
  sleep mode 45
  TCP Remoting Channel 10

web browser
  system requirements 9
Web browsers, supported 9
Windows
  fax service component 18
  regional and short date format 49
Windows 7
  sleep mode 43-44